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General

Designating Applications to Launch  
at Startup

I often find it very useful to have certain 
applications like Safari, Entourage and 
FileMaker launch when I boot up my Mac, 
saving me the extra steps of launching each 
one separately. 

Unfortunately, there’s not a “Launch at 
Startup” preference pane in System Prefer-
ences. You need to dig a little deeper to 
access this function. 

In System Preferences click on the 
Accounts pane, then be sure your Login 
account is highlighted in the account list at 
the left of the window. 

Choose Login Items and you’ll see the 
list of applications that currently open 
automatically when you log in. Click on 
the plus icon at the bottom of the list and 
select the application(s) you’d like to add to 
the list. 

Next time you log in (or startup if your 
Mac always logs into your account), these 
applications will open automatically.

macHOME HotTips

Cursing the Cursor
Q: I just purchased my first Mac after 

using Windows for many years. I would 
like to replace my arrow cursor with some-
thing bigger and perhaps with a different 
picture. How do I do this? ~ Joe Robertson

A: Joe, better that I break it to you than 
a passing stranger in a Wi-Fi coffee shop: 
most Mac users would no more replace 
Apple’s elegant black arrow cursor with 

some pixelated sparkler than we would slap 
rouge and lipstick on the Venus de Milo.

But que sera, sera. You can change your 
Mac’s cursor with the help of Unsanity’s 
Mighty Mouse ($10). This haxie, or small 
bit of code written to tweak OS X, allows 
you to customize the Mac’s built-in cursors, 
turning your wait cursor into a wiggling 
mermaid or a purple bouncing alien, for 
instance. Mighty Mouse lets you choose 
additional cursor images from sites such as 
ResExcellence. You can even import cur-
sors designed for Windows XE.

If, after reflection, all you want is a big 
cursor, change it by going to the Universal 
Access preference pane, clicking on Mouse, 
and adjusting the Cursor Size slider.

Chris Breen’s Mac 911 
via The Finder, Mid-Columbia MUG

Kennewick, WA

What Type of DVD Does My DVD 
Player Play?

Ever send out a DVD only to have your 
client call and tell you that they cannot 
play that DVD? With all the formats 
out there it is a wonder if any of us could 
answer “no”. 

We have -R +R -RW +RW -R DL +R 
DL and that doesn’t even encompass High 
Def DVDS which are now becoming 
available. VideoHelp www.videohelp.com/ 
dvdplayers has a useful page that tells 
which players support which formats. Now 
you can ask your clients which make and 
model DVD player they’ll be using and 
avoid having to reburn.

Sterling Ledet

Please Make a 
Donation!

I am requesting a $5-per-issue 
donation. I believe having 
these tips culled from the many 
various sources is valuable.

If you think it’s worth more 
than $5, please donate more. 
If you believe it is worth less, 
then just donate what you 
think is fair. But please donate 
something. I am hoping to 
receive enough in donations to 
keep Mac Hints & Tips viable. 
 
If you are already a current paid 
subscriber to the Hints & Tips 
Database, that entitles you for 
full access to the newsletters as 
well. Another donation from 
you is NOT requested.  
 
To make a donation, go to 
www.mac-hints-tips.com/
donate.htm. 
 
Thank you all for your 
donations last month. They 
made this issue possible.

Paul Taylor
paul@mac-hints-tips.com

www.videohelp.com/dvdplayers
www.videohelp.com/dvdplayers
htp://www.mac-hints-tips.com/donate.htm
htp://www.mac-hints-tips.com/donate.htm
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Ready for the Worst
One day, you just might waltz up 

to your computer, press the power 
switch, and stare in dumb horror 
as your Mac displays a flashing 
folder, offers a plain blue screen, or 
does little more than whir. It makes 
sense, then, to have a troubleshoot-
ing drive at the ready that can help 
you repair your ailing machine.
Your System Discs

The good news is that you already 
have an emergency boot disc: the 
Mac OS X CD or DVD that you 
bought or that came with your Mac. 
Insert one of these and hold down 
the C key at startup to make your 
Mac boot off the disc. 

Then use the disc’s copy of Disk 
Utility. (If you’re using the Tiger 
installation disc, choose Utilities 
> Disk Utility and then click on 
the First Aid tab when Disk Utility 
launches.)
Commercial Troubleshooting 
Utilities

If you own a utility such as Dis-
kWarrior, TechTool Pro, or Drive 
Genius, these also come on bootable 
discs. Use them as you would your 
system disc.
FireWire Drive

You can create a bootable 
troubleshooting device that, because 
it can hold multiple repair utilities, 
exceeds the capabilities of an OS 
X installation disc. For instance, if 
you have a FireWire hard drive, it 
can probably do the job. (Not all 
FireWire drives are bootable)

If the drive has enough capac-
ity, duplicate your Mac’s current 
startup drive using Mike Bombich’s 
Carbon Copy Cloner ($5). Any 
troubleshooting or repair utilities 
you have on your startup drive will 
work from the FireWire drive. On 
the other hand, you can create a 
fresh emergency drive by installing 

a clean copy of Mac OS on the 
FireWire drive and then installing 
your troubleshooting or repair utili-
ties on it.

When choosing an emergency 
FireWire drive, consider one that 
you can easily slip into a pocket 
or pack in a computer case — for 
instance, LaCie’s $240 Mobile Hard 
Drive or Other World Computing’s 
$250 Mercury On-the-Go (both; 
see our latest review of portable 
FireWire drives). Such a small drive 
will prove a useful companion both 
in your office and on the road.
Older iPod

Do you have an older iPod (first 
through fourth generation)? It can 
also boot a Mac when attached to 
that Mac’s FireWire port. (Sorry, 
current iPod models can’t.) If the 
iPod has about 5GB to spare, you 
can install a bootable version of 
Tiger on it, as well as your trouble-
shooting utilities. This is a very 
handy way to lighten your carry-on 
bag when traveling: all you need is 
your iPod for both tunes and emer-
gency protection.

Note that the iPod was not 
designed to be a primary startup 
drive. It has no vents, and the heat 
buildup from running its drive 
constantly will likely shorten its life. 
But I’ve successfully booted an iPod 
to quickly repair a misbehaving 
Mac without apparent mishap.

Chris Breen’s Mac 911 
via The Finder, Mid-Columbia MUG

Kennewick, WA

Avoid the Most Common  
Mac OS X Font Problems

The Mac OS X approach to fonts 
is something that can leave users 
baffled, and no wonder: many dif-
ferent types are supported, they can 
be stored in a multitude of places, 
and Mac OS X 10.4 Tiger installs 

some duplicate fonts as a default... 
and that’s just for starters.

In many months of font research 
for the recently published “Take 
Control of Fonts in Mac OS X” 
and its companion volume “Take 
Control of Font Problems in Mac 
OS X,” I trolled the Web and 
lurked on many message boards, 
intrepidly experimented on my 
own Macs, and served as the emer-
gency contact for graphic designer 
friends (and their friends, and their 
friends’ friends). Of the many mis-
understandings and management 
mistakes users make, one stands out 
as the most common: consolidating 
fonts into a single Fonts folder.
www.takecontrolbooks.com/fonts-
macosx.html?14@@!pt=TB831 
www.takecontrolbooks.
com/font-problems-macosx.
html?14@@!pt=TB831

I don’t know exactly what moti-
vates people to do this. (I’m not sure 
what motivates me to dig into the 
details of using the Mac — I just do, 
even when I’m not going to write 
about it.) But many users explore 
their systems, change things, and 
sometimes run into trouble. The 
Font Book application included 
with Tiger is such an improvement 
over its previous version that there’s 
seldom any need to deal directly 
with Fonts folders. (And graphics 
professionals who need more than 
Font Book use third-party font 
managers that protect them from 
needing to know about Fonts fold-
ers.) But perhaps a user adds a font 
and wants to get rid of what appear 
to be duplicates, or he/she comes 
from a Mac OS 9 background 
where it was more “normal” to 
manipulate font files manually. 
Whatever the reason, when you first 
start poking around on your drive 
looking for where fonts are stored 

www.takecontrolbooks.com/fonts-macosx.html?14@@!pt=TB831
www.takecontrolbooks.com/fonts-macosx.html?14@@!pt=TB831
www.takecontrolbooks.com/font-problems-macosx.html?14@@!pt=TB831
www.takecontrolbooks.com/font-problems-macosx.html?14@@!pt=TB831
www.takecontrolbooks.com/font-problems-macosx.html?14@@!pt=TB831
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(perhaps by doing a Spotlight search 
for folders named “Fonts”), you may 
be surprised to find at least three 
different folders, and perhaps four, 
from Tiger:
•	 In the System directory 

(/System/Library/Fonts)
•	 At the “shared by all users” level 

(/Library/Fonts)
•	 In your home directory 

(~/Library/Fonts)
•	 In the Mac OS 9 System Folder 

(/System Folder/Fonts) if you’ve 
installed Classic.
Installing Adobe’s Creative Suite 

adds another Fonts folder (in /
Library/Application Support/Adobe/
Fonts), and if you have Microsoft 
Office, you get yet another (in 
/Applications/Microsoft Office 
2004/Office/Fonts).

Many people, when faced with 
this seeming mess, decide it’s ridicu-
lous to have fonts spread all over the 
place and start shuffling the files 
around, combining them in only 
one or two Fonts folders.

Despite the apparent simplicity, 
wholesale consolidation is a mistake, 
because where your fonts are stored 
controls what applications (and, 
on a multi-user Mac, which users) 
can see those fonts. Most fonts are 
stored in various locations for good 
reasons. Here’s the scoop on each of 
the Fonts folders listed above.
System Fonts Folder 

Tiger installs 30 fonts in this 
folder (/System/Library/Fonts). Sev-
eral of them are so important that if 
you remove them, your menus and 
dialogs can implode into gibberish 
and your Mac will refuse to start 
up. These all-important fonts are 
LucidaGrande, Geneva, Monaco, 
and Helvetica. Only slightly less 
important are Keyboard and Last-
Resort, fonts that don’t even show 
up in your Font menus. Whether or 

not the two AquaKana OpenType 
files are dispensable is a matter of 
some debate; my considered opinion 
is that, since Apple went to some 
trouble to keep them invisible — 
they don’t show up in Font menus 

— you should leave them alone. In 
fact, leave the System Fonts folder 
completely alone: don’t put fonts in 
it or take them out.

The System Fonts folder has its 
own unique way of interacting with 
you when you try to remove any 
of its fonts: drag a font out and a 
copy is automatically made in the 
destination, with the original left in 
place. The only way you can really 
remove a font from this folder is to 
send it directly to the Trash: drag 
it there, or select it and press Com-
mand-Delete, or Command-click 
or right-click on the icon for a 
contextual menu and choose Move 
To Trash. You’ll have to supply an 
administrative password along the 
way. But while that’s good to know 
in an academic sense, all these safe-
guards against accidental removal of 
system fonts should remind you to 
leave them all alone!
Library Fonts Folder

Fonts in this folder (/Library/
Fonts) can be “seen” by all user 
accounts, so they’re available to 
every user of the machine. On a 
single-user Mac, there’s really no 
difference between storing fonts 
here or in the User Fonts folder. 
Tiger puts 35 fonts in this folder; 
Apple’s iLife and iWork applications 
put their fonts here, too.
User Fonts Folder

Each user account on the Mac 
has its own Fonts folder (~/Library/
Fonts); the fonts in it are available to 
only that user. Tiger doesn’t install 
any fonts in this folder; Microsoft 
Office puts its fonts here — Office 
X provides 15 fonts, but Office 2004 

donates a generous 77 font files! If 
you’re the only user, this is where 
you should put any fonts you install. 
On a multi-user Mac, you might 
want to keep some fonts private to 
a specific account (so they don’t 
clutter other users’ Font menus); to 
share them with all the users of a 
specific machine, they must be in 
/Library/Fonts.
Classic Fonts Folder

If the Classic environment is 
installed on your machine, only 
the fonts in the Mac OS 9 System 
Folder (/System Folder/Fonts) are 
available to Classic applications 
(they’re also available to your Tiger 
applications). 

Unlike Tiger’s wider choice of 
font types, only Mac TrueType 
and PostScript Type 1 fonts work 
in the Classic environment. Tiger 
automatically smoothes fonts on the 
screen in only the Mac OS X envi-
ronment, so if you want your Type 
1 fonts to be drawn correctly on the 
screen (instead of with the famous, 
dreaded “jaggies”) in Classic, you 
need Adobe’s ATM Light version 
4.6.2 or later installed in Classic.
www.adobe.com/products/ 
atmlight/main.html
Adobe’s Fonts Folder

As befits the inventor of Post-
Script fonts, Adobe provides a 
generous assortment of fonts with 
its applications. But when they’re 
in their default location, only 
Adobe applications can access them 
(/Library/Application Support/
Adobe/Fonts). If you want to use 
these fonts in all your applications, 
you must move them to the Library 
Fonts or User Fonts folder. That 
sounds like a good deal until you 
see how non-Adobe applications 
handle the plethora of typefaces for 
these OpenType fonts: Warnock 
Pro, for instance, has 32 different 

www.adobe.com/products/atmlight/main.html
www.adobe.com/products/atmlight/main.html
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typefaces that Word lists in about 
two dozen entries! Moving a few of 
your favorites, and turning them 
on and off through Font Book, is 
a better plan than indiscriminately 
moving all of the Adobe fonts to 
another folder. (Note that you won’t 
see these fonts in Font Book unless 
you move them to one of your 
Tiger Fonts folders; Adobe’s folder 

“belongs” to Adobe’s applications, 
so Font Book doesn’t manage its 
contents.)

Another mistake users make in 
regard to the Adobe Fonts folder is 
deleting it after moving its fonts to 
another Font folder. Adobe buried a 
subfolder in it (/Library/Application 
Support/ Adobe/Fonts/Reqrd/Base) 
that holds more fonts, ones that 
are used by Adobe applications for 
things like its tool palettes. Without 
these fonts in that folder — in 
that specific folder path — Adobe 
applications don’t even open.
Microsoft’s Fonts Folder

This folder (/Applications/
Microsoft Office 2004/Office/Fonts) 
is a red herring that leads to quite 
a bit of confusion in the category 
of “a little knowledge is a dangerous 
thing.” 

If you know that Tiger supports 
“application Fonts folders” such as 
the Adobe one just described, it’s 
perfectly reasonable to assume that 
this folder holds fonts for Microsoft 
applications — especially because 
each of the fonts in it shows up in 
your Fonts menu. 

The confusion starts when you 
take a font out of the folder and 
realize it still appears in your Font 
menu. 

Or, you add a font to the folder, 
and it doesn’t show up in your Font 
menu. 

Or, you notice that all its fonts 
are also in your User fonts folder 

and you decide to delete one or the 
other copy of the over six dozen 
duplicate files.

This folder is a mere storage 
bin; Tiger doesn’t access it at all, 
which is why altering its contents 
has no effect on your Font menus. 
Microsoft Office copies these fonts 
into your User Fonts folder the first 
time you run it; the originals stay in 
place, to be copied for the next user 
account that runs Office, and so on. 
Tiger accesses only the copies in the 
User Fonts folder.
Fonts, Fonts, Everywhere

Don’t assume that just because 
Tiger uses so many Fonts folders 
that it doesn’t matter which one you 
use for your fonts, or that the best 
approach is to collect all your fonts 
together for easier management. It’s 
better to understand the differences 
between the folders and store your 
fonts based on how (and who) you 
want to access them.
~ Sharon Zardetto Aker  
sharon@takecontrolbooks.com

[Sharon Zardetto Aker, who has 
written about the Mac since its birth 
in 1984, made her first foray into 
electronic publishing with her recent 
Take Control of Fonts titles. Between 
them, the two ebooks contain over 
350 pages of this kind of information 
about fonts.]

Small Dog Electronics

Mac Maintenance Checklist
Apple posted the Top Ten Tips 

for keeping your Mac healthy this 
week. I think that most of these 
steps are good but I have a contrary 
opinion on a couple, especially the 
notion of using third-party software 
to “optimize” your hard drive 
and the value of installing virus 
software. Nevertheless, the list is 
definitely worth sharing with the 
Kibbles crew!

Top 10 Tips to Keep Your Mac  
in Top Form
1) Keep Things up to Date

Make it a point to check for 
Apple software updates once a 
month to keep your system running 
optimally. From the Apple menu, 
choose Software Update (make sure 
that your computer is connected 
to the Internet). Software Update 
will assess the Apple software 
on your computer and check our 
servers for new versions. If it finds 
any, the updates will appear in the 
Software Update window. Select the 
checkbox for the software you want 
and then click the Install button to 
download and install the software.

I recommend that you check 
more frequently than once a month. 
I have my system preference set to 
check once a week.
2) Put Your Toys Away

You’re not 5 years old anymore 
— make it a point to clear off the 
mess strewn about across your desk-
top and put your files away where 
you can easily find them. This can 
help prevent accidental file deletion 
(you may inadvertently select and 
trash a wanted file with your unde-
sirables) and help you find things 
much more efficiently. You can get 
organized by creating new folders 
(in the Finder, press Shift/Com-
mand/N) and arranging them into 
a workable hierarchy for your files 
at hand, or you can move your files 
into existing folders.

Boy, you should see Hapy’s desk-
top — he needs to do this. He has 
an Apple 30-inch Cinema Display 
and if you look at his desktop it is 
covered by hundreds of little icons 
of files that he keeps there!
3) Name Your Children

Untitled folder 8, Word027.doc, 
DSC_1366.jpg — you’ve prob-
ably got a few (or way more than 
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a few) files and folders that you’ve 
felt less than inspired to properly 
name. Then suddenly you need to 
pluck that prized picture from your 
enormous collection of DSC_0001.
jpg to DSC_1400.jpg named files, if 
you only knew which number it was. 
Go through your generically-named 
files and folders and give them more 
descriptive names so you can find 
what you need fast (though it can 
find files quickly, Spotlight won’t 
find your tabloid-ready Bigfoot 
picture if you left the file alone with 
its cryptic camera-given name).
4) Prune Through Your File Forest

To reduce the amount of clut-
ter on your hard drive, free up 
some disk space by archiving large, 
seldom used files (learn how here), 
and be sure to name the resulting 
archive file appropriately too, so 
you know what’s in it. Delete any 
unnecessary or outdated personal 
files whenever possible and anything 
that you no longer want or need 

— just drag them all into the Trash 
and don’t forget to empty it. Be 
brave. Your computer will reward 
you with improved performance.
5) Repair Disk Permissions

It’s a good idea to make sure that 
your disk permissions are in good 
working order on a regular basis, 
especially after upgrading or install-
ing new software. Open Disk Util-
ity (find it in /Applications/Utilities) 
and select your hard disk icon in 
the left pane. Click the First Aid tab, 
then click Repair Disk Permissions 
to start the process, which can take 
a few minutes to complete. If Disk 
Utility finds any issues, it’ll fix them 
along the way.
6) Back up Your Files

To prevent losing your prized 
or important files, make it a point 
to back up your keepsakes on a 
regular basis. You can back up files 

onto a CD, DVD, external hard 
drive, iPod, iDisk, or other storage 
medium and then delete the copies 
on your hard drive to free up some 
space. To learn how to back up files, 
choose Mac Help from the Help 
menu in the Finder and do a search 
for back up files. To get some ideas 
of what and what not to back up, 
see this page.

Buy .Mac and use Apple’s excel-
lent Backup software that comes 
free with your .Mac subscription!
7) Restart Your Computer Every 
Once in a While

While your Mac can happily 
hum along 24 hours a day, 7 days 
a week, you should restart it every 
once in a while to refresh the 
system if you’re in the habit of 
keeping your computer running all 
day and night. This can help clear 
issues before they arise.
8) Check for Viruses

Macs don’t get anywhere near 
the amount of viruses that Win-
dows PCs are prone to, but that 
doesn’t mean that they can’t get 
infected. If you don’t already have 
antivirus software, you may want 
to consider making a purchase. If 
you have the software installed, 
be sure to keep your virus defini-
tions up to date, you can find the 
latest updates on your software 
manufacturer’s website.

I guess I disagree with Apple here, 
I have not seen any viruses infect-
ing Mac OS X yet and I think that 
virus software right now is a waste 
of money. That may change. Mac 
OS X is not invulnerable but right 
now it is very, very safe.
9) Optimize Your Hard Drive

To ensure the best system 
performance and keep file damage 
to an all- time low, optimize your 
hard drive once a year. Third-party 
utilities such as Alsoft Disk Warrior 

Optimizer and Micromat Tech Tool 
Pro will defragment and optimize 
your drive.

Again I have some questions 
about the value of optimizing your 
drive. Do not do this without hav-
ing a complete backup. I have not 
found any benefit from using third-
party software to optimize your 
hard drive.
10) Clean the Outside Too

Dust and other debris can harm 
your computer’s innards if you allow 
the stuff to build up around your 
workspace. Use a soft, dry, lint-free 
cloth, feather duster, or canned air 
to clean your Mac’s outside as well 
as the surface areas around it. You 
can use a slightly water-dampened 
cloth to clean the screen. Do not 
use any type of liquid cleaner to 
clean your Mac.

Small Dog Electronics

Prosoft Engineering’s  
Data Rescue II

A good friend of ours called with 
a computer problem that I hadn’t 
had to work through yet. The result 
was my education about a new 
utility called Data Rescue II. This 
tool fills a void for those people who 
have Intel-based Macs and a hard 
drive with corrupted data or dam-
aged directory. Symantec doesn’t 
make a disk utility for Mac any 
longer, and DiskWarrior works on 
the Power-PC Macs (for now). Here 
comes Data Rescue II!

The machine in question was a 15 
inch MacBook Pro, and other than 
the obvious check with Apple’s Disk 
Utility application, I wasn’t entirely 
sure how to proceed. This customer 
HAD to have their data, which is a 
pretty common story. The computer 
was working fine for two weeks, and 
then suddenly crashed, and only 
showed the dreaded blinking folder 
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icon. No boot! Luckily, our friend 
lives in the New York metropolitan 
area, and was able to make a trip 
down to one of the Apple retail out-
lets for someone to look at in person. 
This person was able to confirm data 
corruption, and suggested Data 
Rescue II (after handing our friend 
a tissue).

Here’s what Apple says about this 
recovery tool, “Data Rescue II is 
the best data recovery utility on the 
market for recovering files from a 
problem hard drive. Other utilities 
can cause more damage to your 
hard drive and files by trying to 
?fix? the problem, instead of focus-
ing on recovering your files.”

“Do not use a repair utility until 
you’ve safely recovered your impor-
tant files over to a safe location. 
Data Rescue II should be the first 
option to recover your important 
data, before you try any risky 
?repair? utility. 

The current version is compiled 
as a universal binary, which means 
that it can run on OS X 10.4 and 
later Intel-based Macintoshes, as 
well as OS X 10.2.4 and later Pow-
erPC- based Macintoshes.”

Here’s the link for this great util-
ity, Data Rescue II, on our website:
www.smalldog.com/ 
product/40310
~ Art@Smalldog.com

Small Dog Electronics

About Those Desktop Icons
One way to speed your Mac is to 

keep as few icons on your Desktop 
as possible. This is because Mac 
OS X treats each Desktop icon as a 
full-size Finder window, taking up a 
chunk of memory. 

One approach is to create a folder 
or two on your desktop and move 
all your Desktop items into them. 
You can then open and use those 

folders as if they were mini-Desk-
tops. ~ Rob Griffiths

Design Tools Monthly

Quick Print
If you are like me and hate hav-

ing a printer icon on your Desktop, 
you can still print a file without 
opening the application for it. 
Control/click (or right-click on a 
two-button mouse) on the file and 
use the “Print” menu item.

Mouse Droppings, Corvallis, OR

Dictionary Tricks — 
The Dictionary Application

There’s a handy dictionary and 
thesaurus application in the usual 
Applications folder. Quickly launch 
the dictionary by Control/clicking 
(or Right-clicking) clicking on a 
word to bring up a contextual menu, 
and then selecting “Look Up in 
Dictionary.”

By changing the preferences 
for Dictionary, selecting “Open 
Dictionary pane” from “Context 
Menu,” a handy little pop-up will 
appear under the cursor instead 
of the whole application being 
launched. You can launch the main 
application from the pop-up by 
selecting “More.”

Note: This may be dependent on 
having the WorldBook suit installed, 
which comes free with Tiger.

OSXFAQ 
via Allen Kalka, Mt. Dora MUG FL

Zoom In with Mouse
The coolest new feature in Mac 

OS X 10.4.8 update is that if you 
hold down the Control key while 
scrolling with a scroll wheel (or 
a pseudo scroll wheel, such as is 
provided by Raging Menace’s Side 
Track utility), the screen zooms 
smoothly. Screen zooming has been 
available for a long time (see the 

Universal Access preference pane), 
but using keyboard shortcuts to 
zoom in and out is awkward. Scroll 
wheel-based zooming, which you 
can control in the Mouse view of 
the Keyboard & Mouse preference 
pane (and where you can also 
choose another modifier key besides 
Control), will be a boon to anyone 
with less-than-perfect eyesight or 
presenters who want to focus on a 
particular aspect of the screen.

TidBITS.com

Mac OS X

Stopping the Spotting
Q: One frustrating thing about 

using Spotlight is that after I type 
in a term I frequently see quite 
quickly exactly what I’m looking 
for. However, since Spotlight is still 
searching for other hits, the file I’m 
looking for moves down and then 
quickly off the list. Then I have to 
go digging for it! Is there any way 
to get Spotlight to just stop for a 
second so I can click on a file?  
~ Michael A. Britt

A: You can stop a search at 
anytime if you started it within a 
Finder window. Type the term in 
the Spotlight search field in the top 
right and press return. As soon as 
the search begins, you’ll see a small 
x icon appear in the bottom right 
of the window. Just click that to 
stop the search once you’ve found 
that the file. Unfortunately, you 
cannot stop a search you’ve initiated 
through the Spotlight menu.

macHOME HotTips

Get to Desktop/Documents 
Folder Quickly

When you are in the Save dialog 
box, pressing Command/D takes 
you to the Desktop. If you want to 

www.smalldog.com/product/40310
www.smalldog.com/product/40310
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save to the Documents folder, press 
Command/H for Home and select 
the Documents folder from the list 
on the right.

Mouse Droppings, Corvallis, OR

Show/Don’t Show Preview
Click on a graphic in Column 

View and you see a preview of it in a 
Preview Column. Press Command/J 
and turn off the check box for Show 
Preview Column.

Mouse Droppings, Corvallis, OR

Tiger

3 Workflows for Healthy Macs
If you’re like a lot of Tiger users, 

Automator — Apple’s automation 
application, which puts a friendlier 
face on AppleScript — intrigues 
you, yet when you attempt to create 
an Automator workflow, you’re 
lost. Relax — you don’t have to do 
it yourself. If you’re interested in 
maintaining a healthier and more 
efficient Mac, try these prefabri-
cated workflows:

Jesse Hogue’s Maintenance 3.0 
(free): By tapping into Terminal, 
this workflow can repair permis-
sions on your startup drive, verify 
system preferences, run OS X’s 
periodic cron maintenance tasks, 
and update application prebindings 
(a system for optimizing app librar-
ies so the applications themselves 
run more efficiently). You can select 
which tasks you’d like to run or 
simply choose to run them all.

Jesse Hogue’s Back Me Up (free): 
This workflow uses OS X’s rsync 
command to copy the contents of 
one folder to another folder. On 
subsequent backups, it will compare 
the contents of both folders and copy 
only the changed files and folders 

— for example, you might use it to 

back up a folder that contains files 
for a particular work project.

Batch Apply Spotlight 
Keywords (free): If Spotlight spits 
out too many results whenever 
you use it, this workflow will help 
you stop wasting time. It lets you 
select files or folders full of files 
and append Spotlight comments to 
them so you can more easily focus 
your searches. For example, I’ve 
added the comment 911 column to 
my archive of columns so Spotlight 
can quickly find them without also 
listing other Mac 911-related items.

Chris Breen’s Mac 911  
via The Finder, Mid-Columbia MUG 

Kennewick, WA

Recovering Lost Users
Q: When I upgraded my home 

computer to Tiger, I discovered to 
my horror that my entire family was 
missing — well, their login user 
names were, anyway.

After searching for them every-
where, I finally discovered that if I 
add a new user — with the same 
name as the missing user — to the 
login page, my Mac tells me there is 
a folder attached to that name and 
asks if I would like to re-attach it. 
When I click on OK, the old user 
returns. ~ Gino Del Guercio

A: You can also use this tip to 
recover deleted users. Just open 
the Deleted Users folder (found 
within the Users folder at the root 
level of the startup volume), and 
double-click on the DMG file of 
a deleted user — Mary.dmg, for 
example. Then create a new folder 
within the Users folder, give it the 
name of the deleted user you want 
to recover, and copy the contents 
of the mounted disk-image file into 
this new folder. Now launch the 
Accounts preference pane and create 
a user with that name. As Gino 

indicates, your Mac will ask if you’d 
like to attach the deleted user’s files 
to the newly created user.

Chris Breen’s Mac 911  
via The Finder, Mid-Columbia MUG 

Kennewick, WA

Websites

Automator
Listen to David Pogue tell you 

all about “Automator,” a little-
explained new feature in Tiger. 
www.macdevcenter.com/pub/a/
mac/2005/08/09/tigerpodcast3.
html ~ Victoria Maciulski

Fat Bits, Conejo Valley MUG

Dawn’s List of Resources
Flash Resources
Flash Developer Site:  
www.adobe.com/devnet/flash
Free tutorials:  
www.entheosweb.com/ 
Flash/default.asp
More tutorials:  
www.flashguru.co.uk/ 
category/flash-tutorials
An entire list of tutorials: 
www.flashdeveloper.nl/ 
g_flash_Tutorials.html
Illustrator Resources
Adobe training area:  
www.adobe.com/training
Free tutorials:  
www.ndesign-studio.com/ 
resources/tutorials
More tutorials:  
www.designertoday.com/ 
Tutorials.aspx
An entire site of tutorials:  
http://tutorialoutpost.com
Resources for GarageBand, 
Soundtrack Pro and Final Cut

Apple Pro area has been revised 
and has loads of great resources for 
Apple’s creative software:  
www.apple.com/pro

www.macdevcenter.com/pub/a/mac/2005/08/09/tigerpodcast3.html
www.macdevcenter.com/pub/a/mac/2005/08/09/tigerpodcast3.html
www.macdevcenter.com/pub/a/mac/2005/08/09/tigerpodcast3.html
www.adobe.com/devnet/flash
www.entheosweb.com/Flash/default.asp
www.entheosweb.com/Flash/default.asp
www.flashguru.co.uk/category/flash-tutorials
www.flashguru.co.uk/category/flash-tutorials
www.flashdeveloper.nl/g_flash_Tutorials.html
www.flashdeveloper.nl/g_flash_Tutorials.html
www.adobe.com/training
www.ndesign-studio.com/resources/tutorials
www.ndesign-studio.com/resources/tutorials
www.designertoday.com/Tutorials.aspx
www.designertoday.com/Tutorials.aspx
http://tutorialoutpost.com
www.apple.com/pro
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Apple’s GarageBand tutorial:  
www.apple.com/ilife/ 
tutorials/garageband
QuickTime tutorials:  
http://comtechlab.iupui.edu/ 
tutorialsfolder/garageband.html
Creative Calf for newcomers to 
media tools:  
http://creativecalf.creativecow.net
Creative Cow for media pros:  
http://forums.creativecow.net/
index.html
For the others:
Google Earth: 
www.chrisjdavis.org/ 
2006/01/13/google-earth-part-1
Google Earth 101:  
http://nlcommunities.
com/communities/joevans/
archive/2006/04/04/69822.aspx
More on Google Earth: 
www.gearthblog.com/blog/
archives/2006/03/ 
tutorials_for_g.html
iWork:  
www.apple.com/iwork/tutorials
Excel:  
www.microsoft.com/mac/
products/excel2004/using.
aspx?pid=usingexcel2004
AppleScript:  
www.tandb.com.au/ 
applescript/tutorial
More AppleScript: 
http://macscripter.net/unscripted

Small Dog Electronics 

More Great Ways to Waste Time
Feeling the squeeze from all your 

holiday excess? Swing by the Take 
Off Pounds Sensibly Club’s Web 
site: www.tops.org for information 
on how to lose weight and where to 
get started. 

The nonprofit organization offers 
resources to real-time weight-loss 
outlets, as well as links to other 
health sites.

On a lighter note, you might 
enjoy extensive clues to a 25-year 
old Beatlesque conspiracy theory 
holding that, yes, Paul is dead. It’s 
at http://catless.ncl.ac.uk/ 
obituary/paul.html.

MacValley Voice, Sherman Oaks, CA

Blogs And Where To Find Them
Political Blogs
Roger Ailes:
www.rogerailes.blogspot.com
Opinions You Should Have:
http://tomburka.com
Media Girl:
www.mediagirl.org
The News Blog:
http://stevegilliard.blogspot.com
Andrew Sullivan:
http://time.blogs.com/daily_dish
Washington Monthly:
www.washingtonmonthly.com
Independent sources:
http://independentsources.com
American Street:
www.reachm.com/amstreet
The New Wisdom:
www.thenewwisdom.com
Journals, etc.
The Countess:
http://trishwilson.typepad.com/blog
Dave Barry:
http://blogs.herald.com/ 
dave_barrys_blog
Wil Wheaton:
http://wilwheaton.typepad.com
Leo LaPorte:
www.leoville.com/blog
John C. Dvorak:
www.dvorak.org/blog
Bloggerman:
www.bloggerman.com
Chris Breen:
www.macworld.com/weblogs/mac911
Cult of Mac:
http://blog.wired.com/cultofmac
Search for Blogs
Daily Luxé:
www.dailyluxe.com/blog.php

Blog search Engine:
http://blogs.icerocket.com
Blog Pulse:
www.blogpulse.com
Blog It:
www.blogit.com/Blogs
Start Your Own Blog
Blogger:
www.blogger.com
1800Blogged:
www.1800blogged.com
Journal Home:
www.journalhome.com/start.php
Blog City:
www.blog-city.com
~ Victoria Maciulski

Fat Bits, Conejo Valley MUG

Caltech Seismology Lab
Here is an interesting web site 

— the Caltech Seismology Lab 
home page. This page is just what it 
says. It includes current pictures of 
several seismographs and access to 
the Caltech recent earthquakes page 
as you might have seen on the news. 
The URL is: www.gps.caltech.edu/
seismo/seismo.page.html

The Dialog Box 
San Gabriel Valley MUG  

via MacValley Voice 
Sherman Oaks, CA

Hands-Free Photography
This one tells you how to set up 

a hands-free shooting rig for your 
digital photography!  
www.macdevcenter.com/pub/a/
mac/2005/08/05/photography.
html~ Victoria Maciulski

Fat Bits, Conejo Valley MUG

Safari

Safari Passwords
Q: When entering a password for 

the first time online, a Safari dialog 
box asks “Would you like to save 

www.apple.com/ilife/tutorials/garageband
www.apple.com/ilife/tutorials/garageband
http://comtechlab.iupui.edu/tutorialsfolder/garageband.html
http://comtechlab.iupui.edu/tutorialsfolder/garageband.html
http://creativecalf.creativecow.net
http://forums.creativecow.net/index.html
http://forums.creativecow.net/index.html
www.chrisjdavis.org/2006/01/13/google-earth-part-1
www.chrisjdavis.org/2006/01/13/google-earth-part-1
http://nlcommunities.com/communities/joevans/archive/2006/04/04/69822.aspx
http://nlcommunities.com/communities/joevans/archive/2006/04/04/69822.aspx
http://nlcommunities.com/communities/joevans/archive/2006/04/04/69822.aspx
www.gearthblog.com/blog/archives/2006/03/tutorials_for_g.htm
www.gearthblog.com/blog/archives/2006/03/tutorials_for_g.htm
www.gearthblog.com/blog/archives/2006/03/tutorials_for_g.htm
www.apple.com/iwork/tutorials
www.microsoft.com/mac/products/excel2004/using.aspx?pid=usingexcel2004
www.microsoft.com/mac/products/excel2004/using.aspx?pid=usingexcel2004
www.microsoft.com/mac/products/excel2004/using.aspx?pid=usingexcel2004
www.tandb.com.au/applescript/tutoria
www.tandb.com.au/applescript/tutoria
http://macscripter.net/unscripted
www.tops.org
http://catless.ncl.ac.uk/obituary/paul.html
http://catless.ncl.ac.uk/obituary/paul.html
www.rogerailes.blogspot.com
http://tomburka.com
www.mediagirl.org
http://stevegilliard.blogspot.com
http://time.blogs.com/daily_dish
www.washingtonmonthly.com
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this password?” and further states 
that “To review passwords you have 
saved and remove them, open the 
AutoFill pane of Safari preferences.” 
Upon doing so and clicking the 

“Edit” button after “User names and 
passwords”, a window drops down 
with two columns, “Website” and 

“User name,” but not any show-
ing the corresponding passwords. 
Where does Safari store passwords 
and can they be viewed?  
~ Sal Colabrese

A: It’s a bit of a misnomer for 
the button to be labeled “Edit” 
because you can’t actually edit these 
passwords in Safari. In fact, within 
the browser, the best you can do 
is delete an entry and reenter the 
user name and password the next 
time you visit the site. All hope is 
not lost, though. You can view and 
edit the passwords through OS X’s 
Keychain Access, found at Macin-
tosh HD > Applications > Utilities 
> Keychain Access. Just open the 
utility, click your keychain (usually 
‘login’) and you’ll see all secured 
items at the right. Double-click 
on the item you want to edit and 
choose ‘Show password.’ Now you 
must enter your system password 
and click ‘Allow Once.’ The pass-
word will then appear, and you can 
enter a new one if necessary.

macHOME HotTips

 Safari in Slo-Mo
Q: After I upgraded to OS 10.4.4, 

I noticed some odd things happen-
ing with Safari; specifically, some 
images weren’t animating correctly. 
It doesn’t always happen, but every 
once in a while I’d go to a website 
and I’d see an ad or something 
similar that seems to be moving in 
slow motion. This didn’t happen 
with OS 10.4.3. Any ideas what is 
going on? ~ Jeff Green

A: It appears that Safari 2.0.3. 
(417.8) — which is included with 
the OS 10.4.4 upgrade — has 
trouble displaying animated GIF 
images that have frame delays set to 
zero (0) seconds. 

Instead of immediately display-
ing the next frame, Safari holds 
the frame one full second. This 
makes the animation look as if it is 
running in slow motion. (Safari dis-
plays GIFs with 0.1 second delays 
just fine.) 

Unfortunately, there’s no fix for 
this issue yet, other than to use 
another browser. Hopefully Apple 
will address the issue with the OS 
10.4.5 update.

macHOME HotTips

Easily Email a Website Link
In Safari 2.0 (included in Tiger), 

when you find a web page you want 
to share with someone, you can 
easily send its URL to them in an 
email message. 

While Safari is displaying the 
Web page, press Command/Shift/I 
(or choose File > Mail Link To This 
Page). Your default email applica-
tion will launch and create a new 
message that contains the URL 
and has the Web page’s title in its 
subject field. Just address the mes-
sage and add your own personalized 
note if you like.

Macworld Magazine  
via Design Tools Monthly

Apple Mail

Mail Time
Q: How do I make Apple’s Mail 

display a 24-hour format for mes-
sages that appear in my inbox? ~ 
Brian Shin

A: Give an American Mac a 
24-hour clock by using the Interna-

tional preference pane’s Customize 
option. You can make this happen 
through System Preferences. Open 
the International preference pane, 
click on the Formats tab, and click 
on the Customize button next to 
Times. In the resulting sheet, select 
Short from the Show pop-up menu. 
Click on the hour numeral in the 
text field below to reveal a popup 
menu that begins with 1-12 (see 

“On the Clock”). Choose 1-24 and 
click on OK. You’ve now created 
a Custom region. When you next 
open Mail, you’ll find that message 
times are in the 24-hour format.

Chris Breen’s Mac 911 
via The Finder, Mid-Columbia MUG

Kennewick, WA

Email

Mail Mysteries
Q: Whenever I send an email 

with an attachment, the recipient 
says that there are no attachments. 
They say that the files and photos 
are embedded into the email. How 
do I correct this? I spoke with some-
one at Apple, and they didn’t have a 
clue. ~ Ira Steingold

A: Mail uses a technique that 
embeds the files into the email 
message, and depending upon the 
receiver’s email client, the attach-
ments may not arrive as you expect. 
There are two ways to deal with this 
issue. The first is to make a folder 
on your Desktop and add files to it 
(pictures, etc). Now Control/click 
it and choose “Create Archive of 
‘Your Folder’.” This makes a com-
pressed archive of the folder in ZIP 
format. Drag the resulting archive 
(it ends with ‘.zip’) into your mail 
message. Another thing that might 
help is to send attachments that are 
‘Windows Friendly.’ To make this 
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the default setting when you send 
attachments, choose Edit > Attach-
ments > Always Send Windows 
Friendly Attachments.

macHOME HotTips

Mac Connection Doctor
If your connection is lost and 

you cannot receive mail, go to the 
Mac Connection Doctor. Go to 
the Windows menu and pull down 
to Connection Doctor. If there is a 
problem, a red button replaces the 
green button. Click on it to explore 
a solution to the problem.

Mouse Droppings, Corvallis, OR

Address Book

My Favorite Address Book  
Tips and Tricks

Address Book is one of those 
simple, everyday programs that is 
easy to take for granted. In Tiger 
it’s been updated to version 4.0. It 
does the basics, like storing and 
organizing contact data, which can 
easily be searched, saved, exported, 
and backed up. There are also some 
features added for fun.
1) What is a vCard  
and What Can I Do With It?

You may notice the Address 
Book stores contacts as “vCards.” A 
vCard (Virtual Business Card) is 
basically a digital business card that 
stores data in a standard, platform-
independent format. Cell phones, 
iPods, PDAs, computer applications, 
and email programs all use vCards 
to store and exchange data. Because 
vCards are based on an open stan-
dard, they’re very easy to import 
to and export from Address Book. 
This also means that if you ever 
decide to dump Address Book for 
a different program, you can easily 
take your data with you.

The openness of Address Book 
is one its best features. You can 
enter data in Address Book once, 
and then have it almost anywhere. 
Having a .Mac account helps with 
this — it’s the easiest way to sync 
Address Book data to multiple 
computers, and even have it stored 
online for access on any internet-
connected computer.
2) Create Your Own  
Personal vCard

It’s great to have your own vCard 
you can easily email the card to 
friends and clients, who can then 
simply drag and drop the card into 
their own information management 
program. In Address Book, create 
a new card with all of your relevant 
information. Then navigate to Card 
> Make This My Card. If you have 
a photo icon, it will now sport a 
little tab that says “me.” I have two 
cards: my personal vCard, and one 
I use for work. If you want to use 
one card, you can mark some fields 
as private. Select your vCard, then 
navigate to “Preferences” at the 
top of the screen, then navigate 
to “vCard.” Choose the “Enable 
Private Me Card” option. Go back 
to your personal vCard in Address 
Book, and click “Edit.” A series of 
blue boxes will appear. The checked 
fields will be included on your 
public vCard; fields without checks 
are private.
3) Email Your Own Card

If you want to send your card to 
somebody via email (to show you’re 
trendy and cool), choose Card: Go 
To My Card and then File: Export 
vCard. Save your vCard file some-
place convenient for quick access 
(mine is on my desktop), and send it 
as an attachment to any email mes-
sage. You can also drag and drop 
your cards silhouette icon right 
from Address Book onto Apples 

Mail icon in the Dock, which opens 
a New Message window with your 
vCard attached.
4) Instant Email

If you click on the image of the 
gear (the Actions menu) in the 
Address Book’s upper left corner, 
you’ll see an option to “Send Email.” 
This will launch your email program 
and create a new email with the 
contact’s email address in the “To:” 
field. This can save a considerable 
amount of time.
5) Printing Addresses  
from Address Book

There are several ways to print 
addresses from Address Book. 
When you select “File” > “Print,” 
you’ll see a drop-down menu 
reading “Style.” Here there are 
options for printing mailing labels, 
envelopes, lists, and pocket address 
books.

Address Book will print all your 
labels and envelopes directly onto 
dozens of supported Avery, Avery 
metric, and Dynamo label stocks, 
as well as standard envelope formats. 
Imagine the uses: holiday greetings, 
party invitations, a printed newslet-
ter, or a bulk mailing.

You can also print phone and 
email lists from the File > Print 
dialog box.

If you’re traveling without your 
computer, you can print out a 
handy, pocket-size book to take 
your contacts with you.

To go beyond the built-in 
printing formats and templates, 
Apple recommends a third-party 
utility called iDress. 

See this at www.incarna.com.
For quickly printing envelopes 

out of Address Book, I recommend 
“Easy Envelopes.” It’s available from 
Ambrosia Software at this link: 
www.ambrosiasw.com/ 
utilities/easyenvelopes
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6) Create a Group  
in Address Book

This is useful for sending out a 
single email to many recipients, or 
printing envelopes or labels for a 
particular group. 

Here’s how you do it:
•	 Open the Mac OS X Address 

Book.
•	 Press the + button underneath the 

Group column.
•	 Name the new Group list.
•	 Add people to the group by 

dragging and dropping in from 
existing contacts, or typing in 
a new contact. The new contact 
will automatically be added into 
the “All” category.
Now you have a Group. If you 

want to email the Group in Mail, 
simply type the name of the group 
in the “To:” field, and all members 
with email addresses will be added.
7) Accessing a Map  
from Address Book 4

Address Book includes a feature 
for locating addresses on a Map-
Quest Map. This will only work 
when the physical address field in 
the address book is filled out, and 
you have to be connected to the 
Internet. It’s really easy to make 
Address Book generate a map sim-
ply click the tag (such as “Home,” 

“Work,” or “Other”) that appears to 
the left of the address. Want to use 
Google Maps instead of MapQuest? 

Download this plug-in:  
www.briantoth.com/addressbook
8) Share an Address Book

You can give other users access 
to your Address Book, and even 
give them permission to edit entries. 
This is a great feature for families 
and certain businesses. I rarely use 
this feature, but it’s pretty cool. 

The person with whom you wish 
to share your Address Book has to 
be listed in your Address Book, they 

To restore: In Address Book, 
choose Revert to Address Book 
Backup from the File menu. In the 
resulting dialog, locate your backup 
file (it ends with a .abbu extension), 
select it, and click Open.

Alternatively, in Address Book, 
you can select the “All” icon in the 
upper left corner of the application 
window. Navigate to “File” and 
then choose “Export Group vCard.” 
Save the file to a safe location. I 
periodically do this, and then email 
the Group Addresses to myself to 
maintain a safe copy.
Troubleshooting Address Book

There are many articles at  
www.apple.com/support that can 
help resolve trouble with Address 
Book. These articles describe how 
to import contacts from Entourage, 
how to deal with syncing problems 
with specific devices, and how to 
work with older versions of Address 
Book on older versions of Mac OS 
X. Simply type “Address Book” in 
the search bar. ~ ed@smalldog.com

Small Dog Electronics

.Mac

All About iDisk
.Mac’s is Apple’s $99 suite of 

Internet-based services. iDisk is one 
of the best of those services. For 
years, I rarely used iDisk (a copy of 
my 2003 resume is still sitting in 
my Documents folder). However, 
Apple recently made some interface 
improvements to iDisk, particularly 
when it comes to using iDisk via a 
web browser. Now I’m using iDisk 
extensively and have grown to rely 
on its ease of use and convenience.

According to Apple, iDisk allows 
you to “access your files from any 
computer connected to the Internet, 
or even share your files with your 

have to be a .Mac member, and they 
have to be connected to the Internet. 
To do this, navigate to “Preferences” 
> “Sharing” and then select “Share.” 
Then enter the name of the person 
or people with whom you wish to 
share your Address Book. That’s it!
9) Merge Two Records

It’s easy to accidentally end up 
with two vCards for the same per-
son. Address Book makes it easy to 
merge the two. 

Set Address Book to the “Card 
And Columns” view by pushing 
“Command and 1” at the same 
by going to “View” > “Card And 
Columns.” Use the Search bar in 
the upper right corner of Address 
Book to find the two contacts. Click 
on the first in the Name column. 
Hold the shift key and click on the 
second to select them both. Choose 
Card: Merge Selected Cards, and 
the two will merge. You may have 
to manually delete redundant 
information.
10) Use Spotlight in Address Book

Sometimes you’re in the Address 
Book when you want to find a file 
relating to a particular contact. If 
you click on the image of the gear 
(the Actions menu) in the Address 
Book’s upper left corner, you’ll see 
the word “Spotlight” followed by 
the contact’s name.
11) Back up Address Book

The following tip comes verbatim 
from Apple Support Article 301239. 
Read the entire article here: 
http://docs.info.apple.com/article.
html?artnum=301239

To back up: Open Address 
Book and choose Back up Address 
Book from the File menu. A dialog 
appears, asking you to choose a 
save location; it also adds the cur-
rent date to the saved file name too. 
Choose where you want to save the 
backup, then click Save.
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friends and coworkers.” You use 
iDisk to store data, including 
digital photos, movies, music, and 
documents on Apple’s .Mac servers. 
You can launch an iDisk folder 
on your internet-connected Mac 
or Windows XP computer, which 
you use like any other folder, or 
you can access iDisk over the web, 
through a modern web browser 
such as Firefox or Safari.

iDisk is one the most valuable 
features of .Mac. There are other 
services similar to iDisk, the most 
visible being Google’s rumored 
GDrive and Amazon’s emerging 
S3 online storage service, which 
requires you to pay a fee accord-
ing to the size of the data being 
transferred and stored. But iDisk is 
already here, and it’s well tested and 
integrated to the core of Mac OS X.

On a Mac, iDisk can be quickly 
accessed by selecting Finder (or 
clicking on the desktop) > Go > 
iDisk. An iDisk icon will mount 
on your desktop, similar to how 
an iPod or hard drive will show up 
on your desktop. If you open your 
iDisk, you’ll see ten folders (Family 
Pack accounts have an additional 
Shared folder). According to Apple, 
the folders include:

Documents: Store anything 
here, including documents, let-
ters, or spreadsheets. This folder is 
private, and only you have access 
to items in it.

Movies: Copy QuickTime mov-
ies into this folder and you can use 
HomePage to display them on your 
Web pages.

Music: Copy music files and 
playlists to this folder.

Pictures: Copy JPEG or GIF 
files into this folder and use them 
to create custom iCards or display 
them on your Web pages. To 
make it easy to manage and use 

your pictures, store related images 
in subfolders within the Pictures 
folder.

Public: Share items with others 
by placing them inside this folder. 
Anything you put here can be 
viewed or copied by anyone who 
knows your .Mac member name 
(and your Public folder password, 
if you’ve created one) and who 
can access iDisk Public folders. 
For wider access, use HomePage 
to set up a file sharing web page 
that lets everyone on the Internet 
copy items from your Public folder, 
whether or not they’re a .Mac 
member and regardless of the type 
of computer they use.

Sites: The web pages you cre-
ate with HomePage are stored in 
this folder. If you code your own 
web pages, or use a program like 
Dreamweaver, you would put these 
files here.

Groups (for members who 
belong to one or more .Mac 
Groups): This folder contains a 
folder for each of the .Mac groups 
you belong to. Each group’s folder 
contains subfolders that are acces-
sible only to group members.

Shared (for Family Pack 
accounts only): This folder con-
tains files that can be shared by the 
master account and sub-accounts 
within a Family Pack. Files you 
place in this folder will be avail-
able for use by all other accounts 
in your Family Pack group. The 
contents of this folder are counted 
against the master account’s iDisk 
storage quota.

Web: When you use iWeb to 
publish to the web, it uses this 
folder to hold what you publish. 
The Publish button in iWeb puts 
your published site(s) in the Sites 
folder within the Web folder, and, 
and if you provide an RSS feed 

with what you publish, the feed 
is placed in the RSS folder within 
the Web folder. If you create a site 
using another authoring tool, you 
can publish the site by copying 
the files to the Sites folder within 
the Web folder. This new site can 
then be browsed using the address 
http://web.mac.com/username/
folder, where “username” is your 
.Mac user name and “folder” is 
where you saved the new site on 
your iDisk. Any iPhoto 6 album 
you have selected to photocast will 
be in an iPhoto folder in the Sites 
folder in the Web folder.

Backup: Data files that have 
been backed up using Backup soft-
ware appear in this folder.

The remaining two folders in 
your iDisk are read-only:

Library: In OS X v.10.1 
through v.10.3, applications like 
iSync use this folder for the sup-
porting files they need to do their 
work. In OS X v.10.4, this folder 
contains files that support .Mac 
sync.

Software: This folder holds the 
Members Only folder where you’ll 
find software and files available 
exclusively to .Mac members, and 
the Apple Software folder for con-
venient downloads of relevant soft-
ware from Apple. You cannot copy 
files to this folder, and the contents 
of this folder are not included in 
your total iDisk space allotment.

If you’re using a PC running 
Windows XP or later on which you 
can install applications, you can 
download and install the iDisk 
Utility for Windows and mount 
your iDisk alongside the other 
drives to which the machine has 
access. Download the utility from 
the Member Central page on .Mac.

If you’re using Mac OS X v.10.3 
or later, you can use iDisk syncing 
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to create a copy of your iDisk on 
your computer. When you cre-
ate a copy of your iDisk on your 
computer, you can make changes 
to it at any time, even when you’re 
not connected to the Internet. Your 
iDisk will be synchronized the 
next time you are connected. This 
means you can fill up your iDisk, 
and then upload all the news files 
to the .Mac servers all at once, 
rather than uploading the files 
tediously one at a time. You set this 
up in System Preferences > .Mac 
on your Macintosh computer.

You can access your entire 
iDisk from a web browser, such 
as Firefox or Safari on a Mac or 
PC. Either navigate to www.mac.
com and select the iDisk icon in 
the left hand column (the icon 
looks like a globe), or go to: http://
idisk.mac.com/USER-NAME-
HERE?view=web

When you go to http://idisk.
mac.com/USER-NAME-
HERE?view=web, and replace 
USER-NAME-HERE with your 
user name, a dialog box will drop 
down asking you for your Mac user 
name and password. Once these 
are entered, you’ll see an attractive 
page listing all of your iDisk fold-
ers-Documents, Music, Public, etc. 
You can then download these files 
to the computer you’re working on.

Again, you would do this on any 
web-connected computer using a 
modern web browser. If you’re on 
your own XP or OS X computer, 
it’s usually faster to mount your 
iDisk on your computer’s desktop.

One of the really great features 
of .Mac is its public folder. You can 
fill it with files to share with fam-
ily, friends, and colleagues. Apple 
recently improved web access to 
iDisk Public folders. Now you sim-
ply enter the web address idisk.mac.

com/MEMBERNAME-HERE-
Public to see a page that automati-
cally includes download links for 
whatever is currently in your iDisk 
Public folder.

I’ve put something for Kibbles 
readers on my Public page. Here’s 
my Public iDisk page:
http://idisk.mac.com/ 
edwardshepard-Public?view=web

You can also password protect 
your public folder. If you have OS 
10.3 or higher, here’s how to do this 
according to Apple:

Open System Preferences and 
click .Mac. > Click iDisk > Select 
the “Use a Password to Protect your 
Public Folder” checkbox > Type 
the password in the Password and 
Confirm fields > Click OK.

By default, iDisk has a 512 GB 
data limit. You can allocate up to 915 
MB to iDisk. You do this by logging 
into your account settings in your 
.Mac account. If you need more than 
915MB of storage, you can buy more 
storage-up to four gigabytes.

The .Mac bandwidth data trans-
fer limit is currently set at 10 GB 
per month, and if you’re like most 
.Mac members, you still have plenty 
of data-transfer headroom in your 
account-even if you’ve started exper-
imenting with higher-bandwidth 
activities like audio podcasting. If 
you start showing signs of going 
over your limit for the month, you’ll 
receive email alerts with suggestions 
for how to be bandwidth efficient. 
We’ve added a “Details” link to your 
account page where you can check 
your current data transfer status.

And what if your bandwidth 
usage balloons because your podcast 
gets you famous? You can boost your 
.Mac account to 4 GB of storage and 
a very large 250 GB per month of 
data transfer bandwidth by purchas-
ing an account upgrade. Fame has 

its costs but this has to be one of the 
cheapest you’re likely to encounter.

Again, you need to have a .Mac 
account to use iDisk, and .Mac 
costs $99. We have a promotion for 
free shipping on all copies of .Mac, 
and there is currently a $30 mail-in 
rebate on .Mac if you buy it and a 
new Mac at the same time.

Small Dog Electronics 

iPhoto

Practical Contact Sheets
Q: I am a photographer and 

would like to use iPhoto to print 
contact sheets for my clients to 
accompany their CDs of images. 
The problem is that iPhoto won’t 
let me print contact sheets with the 
image numbers — it will print only 
the thumbnails themselves. This 
makes the contact sheets essentially 
useless. Is there a setting I’m 
missing? ~ Ashley Williamson

A: You’re printing contact sheets 
correctly, but, as you suggest, 
iPhoto doesn’t allow you to print 
titles or file names to accompany 
these images. Here’s a way around 
the problem: In iPhoto, select the 
images you’d like to appear on the 
contact sheet and choose Share 
> Export. In the resulting Export 
Photos window, click on the Web 
Page tab. Enter the number of 
columns and rows of pictures you’d 
like to appear on a page; in the 
Thumbnail portion of the window, 
enable the Show Title option (see 

“Creating Contacts”). Click on 
Export to save the pictures to a 
Web page.

When you open that Web page 
in your browser, you’ll discover 
that it carries not only the images 
you selected, but also each image’s 
title (by default, the image 
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number). Now simply print each 
page and you’ve got the contact 
sheet you’re after.

You can continue to put this 
technique to good use by including 
the Web page and its accompanying 
images in a folder on the CD. (The 
folder should contain an index page 
and two folders, labeled Web page 
name-Thumbnails and Web page 
name-Images.) That way, your cli-
ents can browse the thumbnails in 
your contact sheet and then click on 
them to view the full-size images.

Chris Breen’s Mac 911 
via The Finder, Mid-Columbia MUG

Kennewick, WA

iPhoto Libraries
Yes, that’s plural — you can 

have more than one iPhoto Library 
stored on your hard disk, and 
switch between them as you need to.

There can be a couple of reasons 
you might want to do this. If you 
have only a CD burner, and not 
a DVD burner, you might want 
to limit each library to a size that 
fits onto one CD for easy backup. 
(People with very large photo col-
lections may need to limit them to 
what fits on a DVD!) Sometimes 
you may want to keep a separate 
library for images related to a single 
trip, job, or event.

If you’re using iPhoto 5, simply 
hold down the Shift and Option 
keys while launching iPhoto, and 
you’ll be presented with a dialog 
enabling you to select a library to 
open, or to create a new one.

If you’re using iPhoto 4 or earlier, 
you’ll need to get hold of iPhoto 
Library Manager and follow its 
simple instructions. (There are 
alternatives, but this is the one I’m 
familiar with. It’s free from www.
versiontracker.com and similar 
download sites.) Even if you have 

iPhoto 5, you may be interested in 
some of the additional features of 
iPhoto Library Manager.

When switching among multiple 
libraries, you’ll encounter an Open 
dialog in which you have to locate 
the library to be used. This means 
that you need to keep track of their 
locations on your hard disk. The 
default library (the one originally set 
up when you started using iPhoto) 
is in your Pictures folder — it’s a 
folder named iPhoto Library. Sec-
ond and subsequent libraries may be 
located wherever you like.
Backing up your library

If your main concern is to make 
a backup of your iPhoto library for 
safekeeping, you don’t actually need 
to keep your library small enough 
to fit on a CD. There’s another way.

At the bottom of the left hand 
column of iPhoto, make sure that 
you have the Info panel displayed. 
(Click the “I” icon.)

Click one of your album icons; 
then hold down the Command key 
and click other album icons one 
after the other, in whatever order 
suits you. Keep an eye on the Size 
number in the Info panel — you’ll 
see it increase each time you click 
an additional album.

When the “size” has reached a 
figure of 620MB or so, click the 
Burn button and insert a blank 
CD. (Don’t see a Burn button in 
iPhoto 5? Go to the Share menu 
and choose Show in Toolbar > Burn 
Disc. If all that happens is that you 
gain a double arrowhead at the end 
of the toolbar, click that and you’ll 
see the Burn button.)

Repeat the process as required to 
burn your remaining albums. 

When you reinsert a CD burned 
this way, it appears as a CD icon 
in the left hand column of iPhoto, 
with a disclosure triangle that 

you click to reveal all the original 
albums — very convenient.

Small Dog Electronics

iPod

Let it Charge
In processing iPod returns, many 

times the problem is simply a fully 
depleted battery. Customers report 
that the iPod does not respond 
when plugged into a wall charger or 
the computer, but instead displays a 
battery icon with one bar that does 
not flash. In most cases, leaving the 
iPod to charge for 30-60 minutes 
will revive it. If this doesn’t help, 
though, Apple outlines five steps to 
take (the five Rs):
	 1. Reset your iPod.
	 2. Retry with a different USB 

port.
	3 . Restart your computer.
	 4. Reinstall iPod and iTunes 

software.
	 5. Restore your iPod.

While we’re talking about bat-
teries, it never hurts to emphasize 
calibration. After using your 
battery for a while, it’s possible 
you’ll notice reduced capacity. 
Calibration restores the battery to 
its full functionality. For iBooks, 
PowerBook G4, and iPod, plug 
the machine in and wait for it to 
fully charge. On laptops, wait for 
the ring on the power adapter to 
turn green; on iPods, wait until the 
screen indicates “Charged.” Now, 
disconnect the battery and run 
your computer or iPod until it goes 
to sleep. Finally, plug it back in 
and fully charge again.

The procedure is slightly dif-
ferent for the very last generation 
PowerBook G4 (with the dual-layer 
SuperDrive and high-res screen), 
MacBook, MacBook Pro, and 
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MacBook Pro (17-inch). First, fully 
charge the machine. Once fully 
charged, allow the battery to “rest” 
for at least two hours, then discon-
nect the power and run it until the 
machine goes to sleep. Turn the 
computer off, or let it sleep, for at 
least five hours, then fully recharge.

Along these lines, iPod batteries 
tend not to last as long as laptop 
batteries. If your iPod is more than 
a year old, Apple will not cover 
replacement of the battery...but 
Small Dog can help. You can order 
replacement batteries for every kind 
of iPod for self- installation (we’ll 
send you instructions and an enve-
lope to send us the old battery for 
proper disposal) or mail your iPod 
to us for professional installation.

Apple’s battery calibration page: 
http://docs.info.apple.com/ 
article.html?artnum=86284 

The Five Rs:  
www.apple.com/support/ipod

Small Dog Electronics

iChat

iChat Blocked
Q: Every time I open iChat, the 

computer complains that “The 
Firewall is blocking iChat” or 
some such nonsense. I have OS X’s 
firewall turned on, and iChat seems 
to work just fine. I can chat, audio 
chat, video chat and exchange files 
with everyone in my Buddy List. So 
what exactly is being blocked?  
~ Jann Hennessy.

A: You’ll get this message if you 
have Bonjour Instant Messaging 
turned on. Bonjour is Apple’s name 
for a protocol for discovering file, 
print, chat, music sharing and 
other services on local networks. It 
allows you to tap into resources on 
other computers within your local 

network (if you have one). Bonjour 
Instant Messaging is part of this 
protocol, and it lets you chat with 
other people on the same network 
without having to be connected to 
the Internet. (It’s not much good if 
you don’t have a home network that 
other people use regularly, though.) 
You may have accidentally turned 
on Bonjour Instant Messaging the 
first time you set up iChat. It’s easy 
to turn off: Choose iChat > Prefer-
ences and click “Accounts.” Click 

“Bonjour” in the lift at the left, and 
then uncheck the option to “Use 
Bonjour Instant Messaging.” You 
shouldn’t be bothered with the 
firewall message anymore.

macHOME HotTips

iMovie & iDVD

iMovie and iDVD Documents
One of the most common 

problems computer users have is 
that they don’t know where their 
documents are saved. For iMovie 
and iDVD users, the problem can 
be complicated by the fact that 
they’re not quite sure what they’re 
looking for. As it happens, the situ-
ation has recently been complicated 
a bit, as these applications have 
changed the way they save their 
files. Before version 5, a movie saved 
from iMovie consisted of a “project” 
folder containing three items — an 
iMovie reference file with the same 
name as the project, a folder named 

“Media” containing all the movie’s 
component video and audio clips, 
and a QuickTime reference movie 
that was created if the movie was 
sent to iDVD. The project folder 
was saved by default in the “Movies” 
folder located in your Home folder. 
If these components were separated, 
the movie would cease to function.

Apple must have decided that 
making all these component files 
separately visible was more likely to 
create problems than not. In iMovie 
5 (a.k.a. iMovie HD), a saved movie 
consists of nothing more than a 
single document saved in your Mov-
ies folder. Since it contains all the 
movie and audio clips, it is likely to 
be pretty large, but if you decide in 
a year or two’s time that you want 
to trash or move that project, you 
have only one file to identify, and 
therefore don’t have to worry about 
missing some component(s).

iDVD has always created just a 
single reference project document 
(saved by default in the Documents 
folder in your Home folder), and it 
normally didn’t contain the source 
files (i.e. its component movies or 
slides), though there was a “Save” 
option to include them if you 
wanted a complete package.

iDVD 5 continues to save just a 
reference project document when 
using the Save command, but if 
you want to save a complete project 
including all the source files, you 
have to use the new “Archive 
Project” menu command. At this 
point you can elect to save included 
themes and encoded files that 
would make your project transfer-
able to iDVD on any other Mac, 
even if it didn’t have the same 
themes installed.

Understanding how all this 
works will help you avoid the com-
mon problem of incomplete project 
files and will also enable you to 
confidently delete movie and DVD 
material when attempting to recover 
disk space.

Small Dog Electronics
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the world.
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www.ledet.com
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•	 OSXFAQ.com — One of the world’s top OS X tip sites. Currently administered by Scott Sheppard.
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other valuable information. You may request a free sample copy of this monthly newsletter by going to  
www.design-tools.com or calling 303.543.8400.

•	 The macHome Journal, the ultimate magazine for the Macintosh consumer, offering practical advice for everyone. 
macHome Journal offers excellent how-to articles and advice on purchases, and Hot Tips on line.  
www.machome.com.

•	 Macworld Magazine. The ultimate resource for Mac users. Each issue is packed with practical how-tos, in-depth 
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If you are not a member of a Macintosh User Group, I highly recommend that you find one in your area and join. 
User groups are the greatest source of information and help available to all Mac users — from novices to experts. You 
can find one in your area by going to apple.com/usergroups/find. 


